
ĐỀ CƯƠNG TIN HỌC 

C©u 1 :  Phím nào dùng để cố định địa chỉ trong ô hay khối 

A. F1 B. F3 

C. F2 D. F4 

C©u 2 :  Trong Winword, Excel thao tác Undo có công dụng: 

A. Lặp lại thao tác vừa làm B. Hủy bỏ thao tác vừa làm 

C. Xóa khối D. Sao chép khối 

C©u 3 :  Trong Word 2007, để gạch chân cho từng từ (không gạch chân khoảng trống) ta thực hiện: 

A. Vào Home/Font/Underline Style/ Words 

only 

B. Vào Home/Font/Paragraph/ Words only 

C. Nhấn tổ hợp phím Alt+U D. Nhấn tổ hợp phím Ctrl+U 

C©u 4 :  Khi bảng biểu đã được tạo, thao tác Click phải chuột chọn -> Insert -> Columns to the Right có 

chức năng 

A. Chèn dòng trắng về phía trên dòng đặt 

con trỏ 

B. Chèn dòng trắng về phía dưới dòng đặt con 

trỏ 

C. Chèn một cột trắng về phía bên phải vị 

trí con trỏ 

D. Chèn một cột trắng về phía bên trái vị trí con 

trỏ 

C©u 5 :  Trong PowerPoint, để thêm 1 Slide mới, ngoài cách bấm tổ hợp phím Ctrl+M, ta có thể dùng 

lệnh: 

A. Insert  New Slide B. View  Slide Show 

C. Format  Slide Design D. Format  Slide Layout 

C©u 6 :  Để chèn ký hiệu vào văn bản, ta đặt con trỏ tại vị trí cần chèn sau đó vào Tab Insert và chọn: 

A. Symbol B. Table 

C. Picture D. Shapes 

C©u 7 :  Phần mở rộng của Word 2007 là 

A. Docx B. Doc 

C. Xls D. Xlsx 

C©u 8 :  Khi nhập dữ liệu vào ô Excel, phát biểu nào sau đây là sai: 

A. Nếu dữ liệu là số, Excel sẽ tự động canh 

trái 

B. Nếu dữ liệu là ngày, Excel sẽ tự động canh 

phải 

C. Nếu dữ liệu là số, Excel sẽ tự động canh 

phải 

D. Nếu dữ liệu là chuỗi, Excel sẽ tự động canh 

trái 

C©u 9 :  Trong Word, khi nhấn phím Tab trong bảng (Table) con trỏ sẽ: 

A. Di chuyển sang ô liền sau ô hiện hành B. Tạo khoảng cách Tab 

C. Thêm 1 ô vào bảng D. Di chuyển sang ô liền trước ô hiện hành 

  



C©u 10 :  Để thực hiện tìm kiếm một từ hay một cụm từ ta bấm tổ hợp phím: 

A. Ctrl + A B. Ctrl + H 

C. Ctrl + F D. Ctrl + D 

C©u 11 :  Khi nhập dữ liệu trong ô, để ngắt xuống dòng trong ô đó thì: 

A. Ấn tổ hợp phím Ctrl+Enter B. Ấn tổ hợp phím Alt+Shift 

C. Ấn tổ hợp phím Alt+Enter D. Ấn tổ hợp phím Ctrl+Shift 

C©u 12 :  Ô A6 chứa chuỗi "8637736X". Hàm =VALUE(A6) cho kết quả 

A. 8637736 B. Máy báo lỗi 

C. 0 D. Không xuất hiện gì cả. 

C©u 13 :  Các phép so sánh hay các phép toán Logic trong Excel bao giờ cũng cho ra kết quả là: 

A. False B. True 

C. True hoặc False D. Cả True và False 

C©u 14 :  Phím tắt Ctrl + “=” có tác dụng gì? 

A. Căn phải B. Tạo chỉ số dưới 

C. Tạo chỉ số trên. D. Căn trái. 

C©u 15 :  Điền vào chổ trống biết hàm………….(1,3,6,7) cho kết quả là  17 

A. Min B. Max 

C. Average D. Sum 

C©u 16 :  Để căn lề trái ta dùng tổ hợp phím nào: 

A. Ctrl + E B. Ctrl + L 

C. Ctrl + R D. Ctrl + J 

C©u 17 :  Kết quả của công thức =INT(1257.879) là 

A. 1257.0 B. 1258 

C. 1257 D. Không có đáp án đúng 

C©u 18 :  Chức năng DropCap trong Word dùng để thể hiện: 

A. Làm to ký tự đầu tiên của đoạn B. Chữ hoa đầu từ cho toàn bộ đoạn văn bản 

C. Chữ hoa cho toàn bộ đoạn văn bản D. Làm tăng cỡ chữ cho văn bản trong đoạn 

C©u 19 :  Trong word 2007, Paragraph có chức năng gì? 

A. Bôi đen đoạn văn bản cần định dạng B. Mở hộp thoại định dạng Font chữ 

C. Điều chỉnh khoảng cách giữa các đoạn, 

các dòng trên văn bản 

D. Gạch chân dưới chân các ký tự 

C©u 20 :  Trong MS Excel, tham số thứ 4 của hàm Vlookup(..,..,..,..) là 

A. 0 B. 0 và 1 

C. 1 D. 0 hoặc 1 

C©u 21 :  Chọn kết quả đúng nhất:  LEFT(“Thanh pho Da Nang”, 7) sẽ trả về: 

A. “Thanh ph” B. “Thanh p” 

C. Không có câu nào đúng D. “Da Nang” 

  



C©u 22 :  Để trình chiếu một tập tin PowerPoint ta dùng phím: 

A. F5 B. Shift+F5 

C. Alt+F5 D. Ctrl+F5 

C©u 23 :  Để chèn hình ảnh có sẵn trong máy tính vào văn bản, ta đặt con trỏ tại vị trí cần chèn sau đó 

vào Tab Insert và chọn 

A. Picture B. Table 

C. Symbol D. Shapes 

C©u 24 :  Để thực hiện tìm kiếm và thay thế một từ hay một cụm từ ta bấm tổ hợp phím: 

A. Ctrl + A B. Ctrl + D 

C. Ctrl + H D. Ctrl + F 

C©u 25 :  Thao tác nhấp chuột phải vào biểu tượng của tệp tin và chọn Properties là để: 

A. Xoá tệp tin B. Sao chép tệp tin 

C. Đổi tên tệp tin D. Xem thuộc tính tệp tin 

C©u 26 :  Để canh giữa cho một đoạn văn bản, ta nhấn: 

A. CTRL-E B. CTRL-A 

C. CTRL-C D. CTRL-B 

C©u 27 :  Hãy cho biết hàm nào dưới đây trả về giá trị tuyệt đối của một số n? 

A. SQRT(n) B. Mod(n) 

C. Int(n) D. ABS(n) 

C©u 28 :  Nhấp chuột ở đầu một dòng văn bản là để 

A. Chọn 1 dòng văn bản. B. Chọn (hay còn gọi là bôi đen) nhiều dòng văn 

bản. 

C. Xoá toàn bộ văn bản. D. Xoá 1 dòng văn bản. 

C©u 29 :  Để thực hiện tìm kiếm một từ hay một cụm từ ta thực hiện: 

A. Home  Replace B. Home  Find 

C. Insert  Find D. Insert  Replace 

C©u 30 :  Phím chức năng Tab có tác dụng: 

A. Di chuyển con trỏ về đầu dòng B. Lùi văn bản vào với một khoảng cách cố định 

C. Xóa ký tự phía trước con trỏ D. Chuyển con trỏ xuống phía dưới 1 trang. 

C©u 31 :  Cho biết kết quả của công thức =MOD(15,3) 

A. 0 B. 5 

C. Thông báo lỗi D. 3 

C©u 32 :  Muốn khởi động lại hệ điều hành Windows XP ta thực hiện như sau: 

A. Vào bảng chọn Start và Turn off 

Computer  và hộp thoại xuất hiện, chọn 

lệnh Stand By 

B. Vào bảng chọn Start và Turn off 

Computer và hộp thoại xuất hiện, chọn lệnh 

Turn Off 

C. Vào bảng chọn Start và Turn off 

Computer và hộp thoại xuất hiện, chọn 

lệnh Cancle 

D. Vào bảng chọn Start và Turn off 

Computer và hộp thoại xuất hiện, chọn lệnh 

Restart 



C©u 33 :  Trong Excel, để lưu một tập tin mới vào đĩa ta: 

A. Vào menu File, chọn Save B. Cặp phím Ctrl – S 

C. Vào menu File, Nhấn chọn Save As D. Tất cả đểu đúng 

C©u 34 :  Để chuyển con trỏ về cuối dòng ta dùng phím: 

A. Page up B. End 

C. Home  D. Page Down 

C©u 35 :  Chọn phát biểu đúng. Trong Excel: 

A. Không có đáp án nào đúng B. Hàm Vlookup dùng để dò tìm giá trị trong 

bảng phụ theo dòng 

C. Hàm Hlookup dùng để dò tìm giá trị 

trong bảng phụ theo cột 

D. Hàm Vlookup dùng để dò tìm giá trị trong 

bảng phụ theo cột 

C©u 36 :  Giả sử tại ô A2 chứa chuỗi ký tự “Microsoft Excel”. Hãy cho biết công thức để trích chuỗi ký tự 

“soft” từ ô A2 

A. LEFT(A2,9) B. Cả đáp án b và c đều đúng 

C. MID(A2,6,4) D. RIGHT(A2,10) 

C©u 37 :  Các công cụ định dạng trong văn bản như: Font, paragraph, copy, paste, Bullets and 

numbering….. nằm ở thanh thực đơn nào? 

A. Insert B. Page Layout 

C. Home D. Reference 

C©u 38 :  Có thể thoát chương trình Microsoft Word 2007 bằng cách: 

A. Click chuột Office Button/Close B. Tất cả đều đúng 

C. Click chuột vào biểu tượng (close) phía 

trên và ở góc phải cửa sổ làm việc 

D. Sử dụng tổ hợp phím Alt + F4 

C©u 39 :  Để thoát khỏi chương trình soạn thảo văn bản (Word) 

A. Insert exit B. View exit 

C. Button  exit D. Home exit 

C©u 40 :  Chọn phát biểu đúng. Trong Excel: 

A. Không có đáp án nào đúng B. Hàm Left dùng để lấy ký tự ở giữa của chuỗi 

C. Hàm Left dùng để lấy ký tự bên phải của 

chuỗi 

D. Hàm Left dùng để lấy ký tự bên trái của chuỗi 

C©u 41 :  Giả sử ô A1 có chứa điểm thi, tại ô B1 ta lập công thức để tính kết quả, nếu điểm thi dưới 5 sẽ 

ghi là “RỚT”, ngược lại là “ĐẬU”, cho biết công thức nào sau đây đúng 

A. =IF(A1>=5, “ĐẬU”, “RỚT”) B. =IF(A1>=5, “ĐẬU”, IF(A1<5, “RỚT”) 

C. =IF(A1>=5, “RỚT”, “ĐẬU”) D. =IF(A1<5, “ĐẬU”, “RỚT”) 

C©u 42 :  Trong Microsoft Excel các ô A1, A2, A3, A4, A5 có giá trị: 5, 8, 2, 1, 15 công thức =Sum 

($A$1:$A$5) có kết quả là: 

A. 30 B. Excel thông báo lỗi 

C. 31 D. 15 

  



C©u 43 :  Định dạng khung và màu nền trong word 2007 nằm ở bảng hội thoại nào? 

A. Bullets and Numbering B. Page Border 

C. Borders and Shading D. Tab Stop Position 

C©u 44 :  Hàm nào tính giá trị lớn nhất trong Excel 

A. Average B. Min 

C. Sum D. Max 

C©u 45 :  Giả sử ô C3 của bảng tính Excel đang chứa giá trị kiểu ngày 25/09/2007, để tính năm của giá 

trị ngày đang lưu trong ô này ta gõ vào: 

A. =Year(C3) B. Year(C3) 

C. Year(25/09/2007) D. =day(C3) 

C©u 46 :  Các hộp thư điện tử (Email) trên Internet phải tuân thủ theo quy định 

A. Địa chỉ hộp thư không được trùng nhau B. Địa chỉ và mật khẩu không được giống nhau 

C. Mật khẩu không được trùng nhau D. Tất cả đáp án đều đúng 

C©u 47 :  Sử dụng tổ hợp phím Ctrl + S để: 

A. Mở một tài liệu mới B. Lưu một tài liệu 

C. Mở một tài liệu có sẵn trong đĩa D. Đóng chương trình Microsoft Word 2007 

C©u 48 :  Định dạng Font bao gồm các định dạng 

A. Kiểu chữ, cỡ chữ, màu sắc, kiểu gạch 

chân, … 

B. Kiểu chữ, cỡ chữ, màu sắc, lề đoạn văn, … 

C. Kiểu chữ, cỡ chữ, màu sắc, khoảng cách 

giữa các dòng, … 

D. Kiểu chữ, cỡ chữ, màu sắc, hướng giấy, … 

C©u 49 :  Khi nhấp chuột phải tại 1 đối tượng nào đó và nhấn tổ hợp phím Shift + Delete thì: 

A. Đối tượng đó sẽ được đưa vào Recycle 

Bin 

B. Đối tượng đó sẽ mất và không thể phục hồi 

C. Đối tượng sẽ mất dữ liệu của nó D. Đối tượng sẽ được chọn 

C©u 50 :  Trong Word 2007 để ngắt cột ta đặt con trỏ tại vị trí muốn ngắt cột rồi thực hiện: 

A. Insert  Breaks  Column B. Home  Breaks  Column 

C. Page Layout  Breaks  Column D. View  Breaks  Column 

C©u 51 :  Để thu nhỏ cửa sổ cực tiểu ta thực hiện: 

A. Không thể thu nhỏ B. Nháy nút  

C. Nháy nút  D. Nháy nút  

C©u 52 :  Để xem văn bản trước khi in ta thực hiện: 

A. Nhấn nút in trên thanh công cụ B. Tất cả đều đúng 

C. Nhấn nút print preview trên thanh công 

cụ 

D. Nhấn tổ hợp Ctrl + B 

C©u 53 :  Để định dạng chữ in đậm ta dùng tổ hợp phím: 

A. Ctrl + A B. Ctrl  + B 

C. Ctrl + C D. Ctrl + D 

  



C©u 54 :  Để dán dữ liệu vào một vị trí nào đó, ta thực hiện: 

A. Ctrl + V B. 

Lick vào biểu tượng  

C. Tất cả đều đúng D. Lick chuột phải chọn Paste 

C©u 55 :  Để chèn tiêu đề trang cho văn bản ta thực hiện: 

A. Home  Header B. View  Header 

C. Insert  Header D. Page Layout  Header 

C©u 56 :  Để căn lề đều ta dùng tổ hợp phím nào: 

A. Ctrl + L B. Ctrl + J 

C. Ctrl + E D. Ctrl + R 

C©u 57 :  Hàm nào tính giá trị trung bình trong Excel 

A. Sum B. Max 

C. Min D. Average 

C©u 58 :  Trong các phần mềm sau, phần mềm nào là phần mềm ứng dụng? 

A. Windows XP B. Linux  

C. Unix D. Microsoft Word 

C©u 59 :  Phím backspace có tác dụng gì? 

A. Xóa các ký tự phía sau con trỏ B. Xóa các ký tự phía trước con trỏ 

C. Đưa con trỏ về đầu dòng  D. Đưa con trỏ về cuối dòng. 

C©u 60 :  Phát biểu nào sau đây đúng 

A. Thư mục có thể chứa tệp tin. B. Tệp tin có thể chứa thư mục. 

C. Thư mục và tệp tin đều có phần mở 

rộng. 

D. Thư mục có phần mở rộng còn tệp tin thì 

không. 

C©u 61 :  Winword không có chức năng nào sau đây 

A. Tạo bảng tính. B. Tìm kiếm và thay thế từ. 

C. Chèn k  tự đặc biệt. D. Tạo bảng biểu. 

C©u 62 :  Trong Word, muốn đưa 1 dòng từ dưới lên dòng ngay trên nó ta đặt con trỏ ở vị trí 

A. Cuối dòng trên, nhấn phím Delete B. Đầu dòng trên, nhấn phím BackSpace 

C. Cuối dòng trên, nhấn phím BackSpace D. Đầu dòng hiện hành, nhấn phím Delete 

C©u 63 :  Trong Excel, để rút trích dữ liệu ta dùng: 

A. Data/Sort B. Data/Search 

C. Data/Auto Sort D. Data/Filter 

C©u 64 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Chữ đậm B. Chữ gạch chân 

C. Chữ nghiêng D. Căn phải 

  



C©u 65 :  Khi đang làm việc với trang Word 2007 muốn mở một trang mới để làm việc người sử dụng 

nhấn tổ hợp phím tắt 

A. Ctrl + N B. Shift + N 

C. Shift + V D. Ctrl + V 

C©u 66 :  Muốn chạy một chương trình trong Windows ta trỏ chuột tới Shortcut (biểu tượng đường đi 

tắt đến đối tượng) và thực hiện: 

A. Right Click lên Shortcut B. Double Click lên Shortcut 

C. Click lên Shortcut D. Tất cả các cách đều được 

C©u 67 :  Trong  MS excel ô B2 chứa giá trị 100, C2 chứa 200. Công thức 

=IF(LEFT(“ABCDED”,3)=”ABC”,B2,C2) có kết quả là: 

A. C2 B. 150 

C. B2 D. 100 

C©u 68 :  Trong Excel, hàm Average(3,4,5) cho kết quả là: 

A. 3 B. 5 

C. 6 D. 4 

C©u 69 :  Tại ô A1 chứa giá trị là 12, B2 chứa giá trị 28. Tại ô C2 có công thức AVERAGE(A1:B2) thì kết 

quả tại ô C2 là 

A. 50 B. 40 

C. 20 D. 30 

C©u 70 :  MS. Excel là một hệ bảng tính chạy trên Windows dùng: 

A. Vẽ đồ thị B. Tất cả đều đúng 

C. Thực hiện tính những phép tính D. Sắp xếp tìm kiếm 

C©u 71 :  Biểu thức =IF(2>3,”Sai”) cho kết quả là: 

A. True B. “Dung” 

C. False D. “Sai” 

C©u 72 :  
Muốn in văn bản ta nhấp vào nút  và chọn 

A. Print B. Print Review 

C. Page setup D. Save 

C©u 73 :  Muốn sao chép 1 đối tượng, ta nhấp chuột phải tại đối tượng đó và chọn: 

A. Copy B. Delete 

C. Cut D. Paste 

C©u 74 :  Để thay đổi thứ tự hiển thị dữ liệu ngày tháng 

A. Vào menu Format - Cells - Number của 

Excel… 

B. Vào Control Panel - Regional and Language 

Options… 

C. Vào Control Panel - Date/ Time… D. Vào menu Format - Number của Excel… 

C©u 75 :  Để kết thúc việc trình chiếu trong powerpoint ta nhấn phím nào dưới đây 

A. Delete B. Ctrl 

C. Insert D. Esc 

  



C©u 76 :  Để định dạng trang văn bản ta chọn: 

A. Home / page setup B. Page layout / page setup 

C. Insert/ page setup D. View / page setup. 

C©u 77 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Căn phải B. Căn trái 

C. Căn giữa D. Căn đều hai bên 

C©u 78 :  Chọn địa chỉ Email hợp lệ: 

A. diachi@yahoo.com B. Diachi.org.com 

C. www.diachi.yahoo.com D. Diachi.yahoo.com 

C©u 79 :  Kết quả của công thức =ROUND(1257.879,1) là: 

A. 1257.80 B. 1257.8 

C. 1257.9  D. 1257.1 

C©u 80 :  Hàm Vlookup là: 

A. Hàm dò tìm theo hàng và cột B. Hàm dò tìm theo cột 

C. Hàm tính trung bình cộng D. Hàm dò tìm theo hàng 

C©u 81 :  Trong hệ điều hành Windows, muốn thay đổi hình nền cho màn hình Desktop, ta nháy phải 

chuột tại vùng trống trên Desktop và: 

A. Tất cả các   trên đều sai B. Chọn Properties và chọn thẻ lệnh 

Settings và chọn hình ảnh làm nền màn 

hình và Apply và Ok 

C. Chọn Properties và chọn thẻ lệnh Screen 

save và chọn hình ảnh làm nền màn 

hình và Apply và Ok 

D. Chọn Properties và chọn thẻ lệnh 

DeskTop và chọn hình ảnh làm nền màn 

hình và Apply và Ok 

C©u 82 :  Để định dạng hình ảnh ta thực hiện chọn hình: 

A. Chọn chuột trái  Format autoshapes… B. Chọn chuột trái  Format picture… 

C. Chọn chuột phải  Format picture… D. Chọn chuột phải  Format autoshapes… 

C©u 83 :  Hàm nào dưới đây trả về giá trị là phủ định của biểu thức logic 

A. Or B. Cả ba 

C. And D. Not 

C©u 84 :  Đang soạn thảo văn bản bằng WinWord, muốn thoát, ta có thể: 

A. Nhấn Alt-F4  B. Nhấn Ctrl-F4  

C. Nhấn Esc  D. Nhấn Ctrl-Q 

C©u 85 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Chữ gạch chân B. Căn phải 

C. Chữ đậm D. Chữ nghiêng 
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C©u 86 :  Chọn phát biểu đúng. Trong Excel: 

A. Hàm Mid dùng để lấy ký tự bên trái của 

chuỗi 

B. Không có đáp án nào đúng 

C. Hàm Mid dùng để lấy ký tự bên phải của 

chuỗi 

D. Hàm Mid dùng để lấy ký tự ở giữa của chuỗi 

C©u 87 :  Muốn chuyển đổi qua lại giữa các cửa sổ chương trình ta nhấn tổ hợp phím 

A. Shift-Tab B. Alt-Tab 

C. Ctrl-Tab D. Tab 

C©u 88 :  Để trình chiếu trang đang soạn thảo trong powerpoint ta sử dụng tổ hợp phím nào dưới đây? 

A. F4 B. Ctrl + F5 

C. F5 D. Shift + F5 

C©u 89 :  Trong MS Excel ô A3 chứa chuỗi “A150”, công thức = IF(LEFT(A3,1)=”A”,100,150) có kết quả là: 

A. TRUE B. A 

C. 150 D. 100 

C©u 90 :  Để di chuyển một đoạn văn bản trong word ta thực hiện bôi đen: 

A. Chọn chuột trái  cut …. B. Chọn chuột phải  cut 

C. Chọn chuột phải  copy D. Chọn chuột trái  copy …. 

C©u 91 :  Để vẽ biểu đồ trong Excel ta chọn: 

A. Format\ Chart B. Table\ Chart 

C. Cả a, b, c đều đúng D. Insert\ Chart 

C©u 92 :  Trong Excel hàm tính tổng là hàm nào dưới đây 

A. Average B. Min 

C. Max D. Sum 

C©u 93 :  Trong word 2007, Paragraph có chức năng gì? 

A. Bôi đen đoạn văn bản cần định dạng B. Điều chỉnh khoảng cách giữa các đoạn, các 

dòng trên văn bản 

C. Mở hợp thoại định dạng Font chữ D. Gạch chân dưới các ký tự 

C©u 94 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Căn phải B. Căn đều hai bên 

C. Căn trái D. Căn giữa 

C©u 95 :  Tập tin có phần mở rộng .pptx cho biết đó là tập tin tạo bằng 

A. PowerPoint 2007 B. Word 2007 

C. Excel 2007 D. Paint 2007 

C©u 96 :  Biểu thức sau cho kết quả bao nhiêu nếu giá trị hiện tại của DTB là 9: =IF(DTB>=8, "GIỎI", 

IF(DTB>=6.5, "KHÁ",IF(DTB>=5, "TB","YẾU"))) 

A. GIỎI B. YẾU 

C. TB D. KHÁ 

  



C©u 97 :  Trong MS excel công thức =MID(“Microsoft Excel”,6,4) có kết quả là 

A. “excel” B. EXCEL  

C. “Excel” D. soft 

C©u 98 :  Giả sử trong ô A1 có giá trị TN34X, hàm =value(mid(A1,3,2)) cho giá trị là gì 

A. TN B. 34 

C. Lỗi D. X 

C©u 99 :  Chọn phát biểu đúng. Trong Excel: 

A. Hàm Round dùng để tính tổng B. Không có đáp án nào đúng. 

C. Hàm Round dùng để tính trung bình D. Hàm Round dùng để làm tròn số 

C©u 100 :  Giả sử ô A1 có giá trị 7.263 và ô A2 có giá trị 5.326. Công thức =ROUND(A1,2)-INT(A2) cho kết 

quả: 

A. 1.901 B. 2.26 

C. 2 D. 2.2 

C©u 101 :  Trong Excel, hàm Max(3,4,5) cho kết quả là: 

A. 6 B. 4 

C. 3 D. 5 

C©u 102 :  Tại ô A5 nhập chuỗi ”TINHOC”, cho biết kết quả khi thực hiện lệnh =LEFT(A5) 

A. “TINHOC” B. #VALUE 

C. “T” D. FALSE 

C©u 103 :  Trong hệ điều hành Windows, để xoá các tệp/thư mục đang chọn ta thực hiện như sau: 

A. Các   trên đều đúng B. Vào bảng chọn Edit và UnDelete và Yes 

C. Nhấn tổ hợp phím Ctrl + Delete và Yes D. Nhấn phím Delete và Yes 

C©u 104 :  Để chuyển con trỏ lên trang trước của trang hiện hành ta dùng phím: 

A. Backspase B. Page up 

C. Page Down D. Home 

C©u 105 :  Để lưu văn bản với một tên mới ta thực hiện: 

A. Nhấn tổ hợp phím Ctrl + S B. Nhấn tổ hợp phím Ctrl + C    

C. Nhấn phím F12 D. Không đáp án nào đúng 

C©u 106 :  Để thoát khỏi một chương trình ứng dụng, ta dung tổ hợp phím: 

A. Ctrl+F4 B. Alt+F4 

C. Shift+F4 D. F4 

C©u 107 :  Phím Delete có chức năng: 

A. Di chuyển con trỏ về đầu dòng B. Xóa ký tự phía sau con trỏ 

C. Lùi văn bản vào với một khoảng cách cố 

định 

D. Di chuyển con trỏ về cuối dòng 

C©u 108 :  Để khởi động lại nhanh máy tính trong lúc đang việc với máy mà gặp sự cố nào đó, ta dùng tổ 

hợp phím nào sau đây 

A. Ctrl_Alt_Del B. Ctrl_Alt_Shift 

C. Ctrl_Shift_Del D. Ctrl_Alt_Del_Shift 



C©u 109 :  Khi ta nhập dữ liệu Ngày Tháng Năm, nếu giá trị Ngày tháng năm đó không hợp lệ thì Excel coi 

đó là dữ liệu dạng 

A. Thời gian B. Công thức 

C. Chuỗi D. Số 

C©u 110 :  Để mở file Word 2007 đã có ta dùng tổ hợp phím tắt: 

A. Ctrl + O B. Ctrl + V 

C. Shift + X D. Shift + P 

C©u 111 :  Trong MS Excel ô B5 chứa chuỗi “A01” công thức = VALUE(RIGHT(B5,2)) có kết quả là 

A. 01 B. 2 

C. 5 D. 1 

C©u 112 :  Muốn đổi tên 1 đối tượng, ta nhấp chuột phải lên đối tượng và chọn 

A. Rename B. Remove 

C. Edit D. Send to 

C©u 113 :  Có thể khởi động chương trình Microsoft Word 2007 bằng cách: 

A. Start/program/Microsoft 

Office/Microsoft Word 2007 

B. Cả A và B đều đúng 

C. Click double trái chuột vào biểu tượng 

trên Desktop 

D. Cả A và B đều sai 

C©u 114 :  Để định dạng chữ in nghiêng ta dùng tổ hợp phím: 

A. Ctrl + U B. Ctrl + I  

C. Ctrl + V D. Ctrl + C 

C©u 115 :  Trong cửa sổ Windows Explorer, nếu ta vào bảng chọn View, chọn lệnh List, có nghĩa là ta đã 

chọn kiểu hiển thị nội dung của cửa sổ bên phải chương trình dưới dạng 

A. Các biểu tượng lớn B. Các biểu tượng nhỏ 

C. Danh sách. D. Danh sách liệt kê chi tiết 

C©u 116 :  Muốn chọn tất cả các đối tượng ta nhấn tổ hợp phím tắt nào sau đây: 

A. Ctrl + A B. Ctrl + P 

C. Ctrl + C D. Ctrl + D 

C©u 117 :  Bạn mở Word và gõ thử vào đó một vài chữ, sau đó bạn nhấn chuột vào biểu tượng (x) ở góc 

phải trên của cửa sổ. Điều gì sẽ xảy ra 

A. Một câu thông báo sẽ  hiện ra, yêu cầu 

chọn Yes - No – Cancel. 

B. Cửa sổ trên được đóng lại. 

C. Cửa sổ trên được thu nhỏ lại thành một 

biểu tượng. 

D. Cửa sổ trên được phóng to ra. 

C©u 118 :  Trong bảng tính Excel, hàm nào sau đây cho phép tính tổng các giá trị kiểu số thoả mãn một 

điều kiện cho trước: 

A. Count B. Countif 

C. Sum D. Sumif 

  



C©u 119 :  Hệ điều hành Windows đưa ra thông báo lỗi khi 

A. Tạo thư mục con mới trùng với tên của 

một thư mục con đã có trong thư mục 

hiện hành. 

B. Tên thư mục có khoảng trống. 

C. Tên thư mục mới là  New Folder. D. Tên thư mục mới có chứa dấu chấm (ví dụ: 

DETHI.190130). 

C©u 120 :  Người và máy tính giao tiếp với nhau thông qua 

A. Bàn phím B. Màn hình 

C. Chuột D. Hệ điều hành 

C©u 121 :  
Biểu tượng có chức năng gì 

A. Dán dữ liệu B. Sao chép văn bản 

C. Di chuyển dữ liệu D. Căn lề giữa hai bên 

C©u 122 :  Định dạng Bullets and Numbering có tác dụng gì? 

A. Chèn các ký tự không có trên bàn phím B. Tạo các dòng kẻ gồm các ký hiệu dấu chấm(.), 

hay gọi là định vị bước nhảy của con trỏ trên 

dòng văn bản 

C. Tạo ra các số thứ tự, ký hiệu tự động ở 

đầu mỗi đoạn văn bản 

D. Căn lề trái, lề phải một đoạn văn bản 

C©u 123 :  Trong word 2007, muốn định dạng Font chữ ta có thể điểu chỉnh bằng cách: 

A. Ấn tổ hợp phím Ctrl + D B. Tất cả đều đúng 

C. Định dạng Font chữ trên thẻ Home D. Home/Font 

C©u 124 :  Trong word 2007, phím tắt để hủy bỏ thao tác vừa chọn là: 

A. Ctrl + Y (F4) B. Ctrl + Z 

C. Ctrl + L D. Ctrl + T 

C©u 125 :  Khi bảng biểu đã được tạo, thao tác Click phải chuột chọn -> Insert -> Rows Above có chức 

năng 

A. Chèn dòng trắng về phía dưới dòng đặt 

con trỏ 

B. Chèn một cột trắng về phía bên trái vị trí con 

trỏ 

C. Chèn dòng trắng về phía trên dòng đặt 

con trỏ 

D. Chèn một cột trắng về phía bên phải vị trí con 

trỏ 

C©u 126 :  Chọn phát biểu đúng. Trong Excel: 

A. Hàm Right dùng để lấy ký tự bên trái của 

chuỗi 

B. Hàm Right dùng để lấy ký tự ở giữa của chuỗi 

C. Không có đáp án nào đúng D. Hàm Right dùng để lấy ký tự bên phải của 

chuỗi 

  



C©u 127 :  Ðịa chỉ của một khối dữ liệu hình chữ nhật  trong Excel được xác định bởi địa chỉ như sau 

A. <ô đầu tiên góc trên trái> : <ô cuối cùng 

góc dưới trái> 

B. Cả ba câu đều sai 

C. <ô đầu tiên góc trên trái> : <ô cuối cùng 

góc dưới phải> 

D. <ô đầu tiên góc trên phải> : <ô cuối cùng góc 

dưới trái> 

C©u 128 :  Khi đặt chuột tại đường viền của của sổ, thao tác Drag and Drop chuột cho phép 

A. Ẩn cửa sổ B. Thay đổi kích thước cửa sổ 

C. Mở cửa sổ lớn tối đa D. Đóng cửa sổ 

C©u 129 :  Trong Excel, hàm Min(3,4,5) cho kết quả là: 

A. 4 B. 5 

C. 6 D. 3 

C©u 130 :  Muốn tạo 1 thư mục mới ta nhấp chuột phải vào vùng trống và chọn 

A. New -> Folder B. View -> Object 

C. New -> Object D. View -> Folder 

C©u 131 :  Để thực hiện tìm kiếm và thay thế một từ hay một cụm từ ta thực hiện: 

A. Home  Find B. Insert  Replace 

C. Home  Replace D. Insert  Find 

C©u 132 :  Trong bảng tính Excel, nếu trong một ô tính có các kí hiệu #####, điều đó có nghĩa là gì 

A. Chương trình bảng tính bị nhiễm virus B. Công thức nhập sai và Excel thông báo lỗi 

C. Hàng chứa ô đó có độ cao quá thấp nên 

không hiển thị hết chữ số 

D. Cột chứa ô đó có độ rộng quá hẹp nên không 

hiển thị hết chữ số 

C©u 133 :  Chọn phát biểu đúng: 

A. Muốn phục hồi đối tượng đã xóa ta vào 

Recycle Bin chọn đối tượng cần phục hồi 

và nhấp Restore 

B. Khi chọn 1 đối tượng và nhấn tổ hợp 

Shift+Delete thì ta có thể phục hồi đối tượng 

đó nhanh chóng 

C. Shift+Delete xóa tất cả đối tượng mà 

không cần chọn 

D. Không thể phục hồi 1 đối tượng khi đã xóa 

C©u 134 :  Để tạo khung cho trang văn bản trong Word 2007 ta chọn: 

A. Home  Page Borders B. Insert  Page Borders 

C. Page Layout  Page Borders D. View  Page Borders 

C©u 135 :  Trong WinWord muốn kẻ đường thẳng cho thật thẳng thì phải đè phím gì trước khi kéo chuột 

A. SHIFT B. ALT 

C. TAB D. CTRL 

C©u 136 :  Chức năng Data/ Filter/ Advance Filter… dùng để: 

A. Tất cả đều sai B. Tổng hợp dữ liệu theo nhóm 

C. Sắp xếp dữ liệu theo nhóm D. Trích lọc dữ liệu theo điều kiện 

  



C©u 137 :  Muốn lựa chọn nhiều đối tượng liên tiếp, ta nhấp vào đối tượng đầu tiên và giữ phím nào 

trước khi nhấp vào đối tượng cuối cùng: 

A. Shift B. Ctrl 

C. Alt D. Home 

C©u 138 :  Để chia văn bản thành hai cột: 

A. Home / columns… B. Page layout/columns… 

C. Insert/ columns… D. View/columns… 

C©u 139 :  Trong Excel, để sắp xếp bảng tính ta vào: 

A. Edit, Sort B. Table, Sort 

C. Ba câu trên đều sai D. Data, Sort 

C©u 140 :  Biết ô A3 có giá trị 15. Hàm =MOD(A3/2) sẽ cho kết quả: 

A. 1 B. Máy báo lỗi 

C. 7 D. 0.5 

C©u 141 :  Để căn lề phải ta dùng tổ hợp phím nào 

A. Ctrl + L B. Ctrl + R 

C. Ctrl + E D. Ctrl + J 

C©u 142 :  Với công thức =RIGHT(“OFFICE97”,2) thì kết quả trả về sẽ là 

A. Cả câu a và b đều đúng B. Một kiểu dữ liệu dạng số 

C. Một kiểu dữ liệu dạng chuỗi D. Cả câu a và b đều sai 

C©u 143 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Căn giữa B. Căn trái 

C. Căn phải D. Căn đều hai bên 

C©u 144 :  Chọn phát biểu đúng 

A. Thư mục gốc là thư mục được tạo tự 

động từ các ổ đĩa 

B. Thư mục mẹ chỉ chứa thư mục con 

C. Thư mục gốc là thư mục con của thư 

mục mẹ 

D. Thư mục con là tệp tin 

C©u 145 :  Để gộp ô trong bảng, ta bôi đen các ô cần gộp sau đó nhấp chuột phải và chọn 

A. Merge Cells B. Cell Alignment 

C. Split Cells D. Delete Cells 

C©u 146 :  Trong excel hàm MOD(m,n) có công dụng nào sau đây? 

A. Trả về giá trị là phần nguyên của số thập 

phân n 

B. Làm tròn số thập phân m đến n chữ số lẻ 

C. Trả về giá trị là phần thập phân của số 

thập phân n 

D. Trả về phần dư của phép chia số m cho số n 

  



C©u 147 :  Đường dẫn nào sau đây không hợp lý 

A. Thư mục mẹ\thư mục gốc\ thư mục 

con\tập tin 

B. Thư mục mẹ\thư mục con\tập tin 

C. Thư mục gốc\thư mục mẹ\thư mục 

con\tập tin 

D. Thư mục gốc\tập tin 

C©u 148 :  Chọn kết quả đúng nhất: IF( 18<19, “Sai”, “DUNG”) trả về 

A. “SAI” B. Sai 

C. “DUNG” D. Không có câu đúng 

C©u 149 :  Để xóa hình ảnh trong Word ta thực hiện chọn hình cần xóa: 

A. Bấm phím Home B. Bấm phím End 

C. Bấm phím delete D. Bấm phím Insert 

C©u 150 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Căn giữa B. Căn phải 

C. Căn trái D. Căn đều hai bên 

C©u 151 :  Trong hệ điều hành Windows, muốn đóng (thoát) cửa sổ chương trình ứng dụng đang làm 

việc ta: 

A. Nhấn tổ hợp phím Ctrl + F3 B. Các   trên đều đúng 

C. Vào bảng chọn Edit và Office ClipboarD... D. Nhấn tổ hợp phím Alt + F4. 

C©u 152 :  Để định dạng đoạn văn bản ta chọn bảng chọn nào dưới đây 

A. Page layout B. Home 

C. Insert D. View 

C©u 153 :  Công việc nào dưới đây không liên quan đến định dạng văn bản 

A. Sửa lỗi chính tả B. Thay đổi khoảng cách giữa các dòng 

C. Đổi kích thước trang giấy D. Thay đổi phông chữ 

C©u 154 :  Để tính trung bình cộng của các ô từ A1 đến A5 ta dùng hàm: 

A. = average(A1+A2+A3+A4+A5)/5 B. = average(A1:A5) 

C. = average(A1,A2,A3,A4,A5)/5 D. Tất cả các đáp án đều đúng 

C©u 155 :  Trong MS excel công thức =LEFT(RIGHT(“Microsoft Excel”,5),2) có kết quả là: 

A. Excel B. 2 

C. Ex D. 5 

C©u 156 :  Chọn lệnh tương ứng cho tất cả các thao tác sau: Sao chép/Di chuyển/Xóa/Dán 

A. Copy/Cut/Delete/Paste B. Copy/Delete/Paste/Cut 

C. Cut/Delete/Paste/Copy D. Delete/Copy/Cut/Paste 

C©u 157 :  Để có thể viết hoa một chữ cái trong word ta dùng phím: 

A. Caps Lock B. A và B đều đúng 

C. A và B đều sai D. Shift + chữ cái 

C©u 158 :  Điền vào chổ trống biết hàm………….(1,3,6,7) cho kết quả là  7 

A. Min B. Left 

C. Right D. Max 



C©u 159 :  Tập tin có phần mở rộng xlsx cho biết đó là tập tin tạo bằng 

A. Winword 2007 B. Excel 2007 

C. Access 2007 D. Paint 2007 

C©u 160 :  Để tìm ô có số lớn nhất trong các ô dữ liệu số từ C3 đến C7 trong Excel, dùng công thức 

A. = max(C3:C7) B. MAX(C3:C7) 

C. max(C3:C7) D. Tất cả các đáp án đều đúng 

C©u 161 :  
Trên thanh công cụ căn chỉnh dữ liệu, biểu tượng  có chức năng: 

A. Căn giữa B. Căn phải 

C. Căn đều hai bên D. Căn trái 

C©u 162 :  Trong excel hàm INT(n) có công dụng nào dưới đây? 

A. Trả về giá trị là phần thập phân của số 

thập phân n 

B. Làm tròn số thập phân m đến n chữ số lẻ 

C. Trả về phần dư của phép chia số m cho 

số n 

D. Trả về giá trị là phần nguyên của số thập phân 

n 

C©u 163 :  Thao tác vào Office Button / chọn Print hoặc Ctrl + P được dùng để: 

A. Mở một tài liệu có sẵn trong đĩa B. Đóng chương trình Microsoft Word 2007 

C. Mở bảng chức năng in tài liệu D. Lưu một tài liệu 

C©u 164 :  Hàm nào tính giá trị nhỏ nhất trong Excel 

A. Average B. Max 

C. Sum D. Min 

C©u 165 :  Để phóng lớn / thu nhỏ tài liệu ta thực hiện bằng cách nào? 

A. Giữ phím Ctrl và di chuyển con xoay trên 

con chuột 

B. Điều khiển thanh trượt zoom ở góc phải màn 

hình 

C. Cả A và B đều đúng D. Cả A và B đều sai 

C©u 166 :  Để hiển thị thanh thước kẻ trong Word 2007 

A. Home  Ruler B. Insert Ruler 

C. View  Ruler D. Page Layout  Ruler 

C©u 167 :  Trong Windows, để mở một chương trình ta chọn 

A. Tất cả các đáp án đều đúng B. Start/Program… 

C. Start/Search… D. Start/Setting… 

C©u 168 :  Trong hệ điều hành Windows, muốn tạo thư mục, ta mở ổ đĩa muốn tạo thư mục mới bên 

trong nó và 

A. nháy File và New và Short Cut, gõ tên 

cho thư mục mới và nhấn phím Enter 

B. nhấn tổ hợp phím Ctrl + N, gõ tên cho thư 

mục mới và nhấn phím Enter 

C. nhấn phím F2, gõ tên cho thư mục mới 

tạo và nhấn phím Enter 

D. nháy File và New và Folder, gõ tên cho thư 

mục mới và nhấn phím Enter 

C©u 169 :  Khi sử dụng bộ gõ tiếng Việt với bảng mã VNI Windows, cần chọn font chữ bắt đầu bằng: 

A. Time News Roman B. VNI 

C. .Vn D. SVN 



C©u 170 :  Với  ĐTB cuối năm là 6.5, Lê Hoàng Vy sẽ  đạt xếp loại gì khi biết công thức xếp loại học tập 

=IF(ĐTB<5, “Yếu”, IF(ĐTB<6.5, “TB”, IF(ĐTB<8, “Khá”, “Giỏi”)))? 

A. Giỏi B. TB 

C. Khá D. Yếu 

C©u 171 :  Trong MS excel công thức =LEFT(“Microsoft Excel”,2) có kết quả là 

A. M B. Microsoft 

C. Mi D. Báo lỗi 

C©u 172 :  Để định dạng chữ gạch dưới ta dùng tổ hớp phím nào: 

A. Ctrl + B B. Ctrl + U 

C. Ctrl + I  D. Ctrl + S 

C©u 173 :  Điền vào chỗ trống biết hàm………….(1,3,5,7) cho kết quả là 4   

A. Left B. Right 

C. Max D. Average 

C©u 174 :  Để sao chép một đoạn văn bản trong word ta thực hiện bôi đen: 

A. Chọn chuột trái  copy …. B. Chọn chuột phải  copy 

C. Chọn chuột trái  cut …. D. Chọn chuột phải  cut 

C©u 175 :  Khi muốn sắp xếp các biểu tượng ngoài Desktop theo tên, ta nhấp phải chuột, chọn Arrange 

Icons By và chọn 

A. Name B. Type 

C. Size D. Modified 

C©u 176 :  Trong hệ điều hành Windows, để xem danh sách các tài liệu (tệp) vừa thao tác gần nhất, ta: 

A. Nháy Start và My Documnents  B. Các   trên đều sai 

C. Nháy File và Open Near Documents D. Nháy Start và My Recent Documnents 

C©u 177 :  Ô A1 chứa giá trị số là 7, ô B1 chứa giá trị chuỗi là "ABC". Hàm =AND(A1>5,B1="ABC") sẽ cho 

kết quả là: 

A. 1 B. FALSE 

C. 2 D. TRUE 

C©u 178 :  Muốn Word 2007 mặc định lưu với định dạng của Word 2003, ta làm như thế nào? 

A. Chọn Save. Tại mục Save as type, bạn 

chọn Word Document 

B. Chọn Save. Tại mục Save as type, bạn chọn 

Word Template 

C. Chọn Save. Tại mục Save as type, bạn 

chọn Word 97-2003 Document 

D. Chọn Save. Tại mục Save as type, bạn chọn 

Word 

C©u 179 :  Để sử dụng dịch vụ trên Internet, máy tính phải có: 

A. Một trình duyệt Web B. Loa 

C. Ổ đĩa CD rom D. Webcam 

  



C©u 180 :  Trong hệ điều hành Windows, muốn đóng tệp hiện hành nhưng không thoát khỏi chương 

trình ta 

A. Nháy chuột vào biểu tượng của tệp trên 

thanh công việc (Task bar) 

B. Nhấn tổ hợp phím Alt + F4 

C. Vào bảng chọn File và chọn Exit D. Nhấn tổ hợp phím Ctrl + F4 

C©u 181 :  Chức năng thanh thực đơn Insert cho phép sử dụng các chức năng: 

A. Thiết lập cài đặt, định dạng cho trang 

giấy như: Page setup, Page Borders, 

Page Color, Paragraph,…….. 

B. Định dạng văn bản như : Chèn chú thích, 

đánh mục lục tự động, … 

C. Chèn các đối tượng vào trong văn bản 

như: chèn Picture, WordArt, Equation, 

Symbol, Chart, Table, Header and footer, 

Page number 

D. Chức năng kiểm tra lại như ngữ pháp, chính 

tả… 

C©u 182 :  Giả sử trong ô A1 có giá trị TN34X, hàm =left(A1, 2) cho giá trị là gì 

A. Lỗi B. “TN” 

C. “4X” D. “34” 

C©u 183 :  Trong bảng tính Excel ô A1 chứa giá trị 4, ô B1 chứa 36, C1 chứa 6. Nhập vào D1 công thức: 

=IF(MOD(B1,A1)=0,INT(B1/A1),IF(A1>C1,A1,C1)) Cho biết kết quả trong ô D1: 

A. 6 B. 9 

C. 4 D. 0 

C©u 184 :  Để định dạng hình ảnh  Autoshapes ta thực hiện chọn hình: 

A. Chọn chuột phải  Format picture… B. Chọn chuột trái  Format picture… 

C. Chọn chuột phải  Format autoshapes… D. Chọn chuột trái  Format autoshapes… 

C©u 185 :  Dấu hiệu để nghi ngờ có Virus xâm nhập máy tính là: 

A. Việc thi hành các File chương trình chậm 

hoặc không chạy. 

B. Việc đọc ghi đĩa nhanh hơn bình thường. 

C. Có đủ bộ nhớ khi chạy chương trình. D. Các hiện tượng trên đều không đúng. 

C©u 186 :  Hãy cho biết hàm nào dưới đây trả về giá trị là căn bậc hai của số n? 

A. ABS(n) B. Int(n) 

C. Mod(n) D. SQRT(n) 

C©u 187 :  Để thay đổi nội dung trong ô hiện hành trong Excel, ta thực hiện: 

A. Tất cả các cách đều đúng B. Double Click lên ô đó 

C. Chọn ô đó và nhấp con trỏ lên thanh 

Formula Bar để sửa 

D. Nhấn phím F2 

C©u 188 :  Trong word 2007, phím tắt để gọi lại thao tác vừa thực hiện là: 

A. Ctrl + Z B. Ctrl + Y (F4) 

C. Ctrl + L D. Ctrl + T 

  



C©u 189 :  Khi muốn tắt máy tính, ta thường vào StartTurn Off ComputerTurn Off, nhưng trong một 

số trường hợp ta buộc phải nhấn nút Power, là do 

A. Máy bị treo B. Muốn tắt máy nhanh 

C. Muốn khởi động lại máy tính D. Muốn tắt máy tạm thời 

C©u 190 :  Trong hệ điều hành Windows, muốn tạo một thư mục mới trên màn hình nền ta 

A. Nháy chuột trái tại vùng trống trên màn 

hình nền và New và Folder, gõ tên thư 

mục và nhấn phím Enter 

B. Mở My Computer và Control 

Panel và New và Folder, gõ tên thư mục và 

nhấn phím Enter 

C. Nháy đúp chuột tại My 

Computer và New và Folder, gõ tên thư 

mục và nhấn phím Enter 

D. Nháy chuột phải tại vùng trống trên màn hình 

nền và New và Folder, gõ tên thư mục và 

nhấn phím Enter 

C©u 191 :  Ô C1 chứa dữ liệu dạng chuỗi A115. Nhập công thức =VALUE(RIGHT(C1,3))>0 vào C2. Dữ liệu 

trong ô sẽ là: 

A. 115 B. FALSE 

C. 0 D. TRUE 

C©u 192 :  Muốn lưu văn bản ta thực hiện thao tác 

A. 
Nháy nút  và chọn Save hoặc Save 

As. 

B. 
Nháy nút  và chọn Open. 

C. 
Nháy nút  và chọn Save As. 

D. 
Nháy nút  và chọn Save. 

C©u 193 :  Chọn câu phát biểu sai : 

A. Bảng tính Excel có 256 cột B. Bảng tính Excel chỉ có 2 loại dữ liệu: số và 

chuỗi 

C. Địa chỉ ô được xác định bởi kí hiệu cột và 

số thứ tự dòng 

D. Excel là phần mềm bảng tính của hãng 

Microsoft 

C©u 194 :  Kết quả trả về của công thức: =OR(2>3,4<1) sẽ là 

A. Sai B. Đúng 

C. False D. True 

C©u 195 :  Để tạo bảng ta đặt con trỏ tại vị trí cần chèn sau đó vào Tab Insert và chọn: 

A. Table B. Shapes 

C. Symbol D. Picture 

C©u 196 :  
Biểu tượng  có chức năng gì 

A. Căn lề giữa hai bên B. Dán dữ liệu 

C. Sao chép văn bản D. Di chuyển dữ liệu 

C©u 197 :  Phím tắt Ctrl + Shift + “=” có tác dụng gì? 

A. Tạo chỉ số dưới B. Tạo chỉ số trên 

C. Căn phải D. Căn trái 

  



C©u 198 :  Để chèn chữ Word art ta chọn: 

A. Home / Word art… B. Insert / Word art… 

C. View / Word art… D. Pagelayout / Word art… 

C©u 199 :  Mặc định, tài liệu Word 2007 được lưu với định dạng là 

A. *.DOC  B. *.DOCX 

C. *.EXE  D. *.DOTX 

  


